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SPRACHE IN Paragraph-Style “05 - STANDARD Fließtext” passend einstellen

1 Welcome to GUITAR RIG MOBILE!
GUITAR RIG MOBILE is a professional recording-solution for guitar and bass. It comprises 
the ultra-compact GUITAR RIG MOBILE I/O audio interface and the ESSENTIAL version of 
the critically acclaimed GUITAR RIG 4 software.

The GUITAR RIG MOBILE I/O is a studio-quality audio-interface that connects to your com-
puter via high-speed USB 2.0. It features a Hi-Z input for electric guitars and bass guitars and 
a stereo line-out to connect to a hi-fi system, a mixer, a pair of active speakers or headphones. 
The GUITAR RIG MOBILE I/O audio-interface is designed for use with Native Instruments 
GUITAR RIG 4 software but will work with most professional audio software.

In this manual, you will learn more about GUITAR RIG MOBILE I/O’s features and how to 
make the best use of them. Please read the manual carefully in order to get acquainted with 
the product.
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2 Before you Start – Important Notes
First things first; before using GUITAR RIG MOBILE, it is advised that you read this chapter 
carefully.

2.1 Serial Numbers & Nameplate

GUITAR RIG MOBILE comes with two serial numbers. The GUITAR RIG MOBILE I/O hardware 
serial number can be found on the bottom of the product, while the serial number for the 
included version of GUITAR RIG 4 is located on the cover of the installation CD.

The nameplate is located on the bottom of the product. It lists the product model name and 
other technical information. 

2.2 Using the Unit Safely

Please read the following instructions thoroughly to prevent from health risks and damaging 
the product.

2.2.1 Warning
To prevent hearing damage, always follow these important security advices:

 • This Product, in combination with an amplifier, headphones or speakers, can produce 
sounds in decibel ranges that may cause hearing damage.

 • For protection, set all volume levels to a minimum before using GUITAR RIG MOBILE I/O. 
Gradually raise the volume controls while music is playing to set the desired listening level.

 • Do not operate it at high volume levels for long periods. If you experience any hearing prob-
lems or ringing in the ears, consult an audiologist immediately.
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2.2.2 Caution
To make sure that the GUITAR RIG MOBILE I/O or any device connected is not damaged 
during usage or maintenance, it is important you follow these instructions: 

 • Do not open the device or attempt to disassemble or modify the internal parts. The device 
contains no user-serviceable parts. If it appears to be malfunctioning, discontinue use im-
mediately and have it inspected by qualified service personnel.

 • Do not expose the unit to rain, nor use it near water or in damp or wet conditions.

 • Do not allow any objects or liquids of any kind to penetrate the unit.

 • Never use or store the unit in areas that are subject to temperature extremes (e.g. direct 
sunlight in an enclosed vehicle or near heat-generating equipment) or high levels of vibra-
tion. 

 • Do not place the GUITAR RIG MOBILE I/O in an unstable position where it is possible the 
unit could accidentally fall. Remove all connected cables before moving the unit.

 • Before turning the power on or off for any component, set all volume levels to their minimum. 

 • Do not use excessive force on the knobs or connectors.

 • When cleaning the GUITAR RIG MOBILE I/O, use a soft, dry cloth. Never use paint thinners, 
solvents, cleaning fluids or chemical-impregnated wiping cloths.

2.2.3 Disposal Notice
Should this product become damaged beyond repair, or if you wish to dispose it, please ob-
serve the regulations of your area and country that relate to the disposal of electronic products.
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2.3 Disclaimer

Native Instruments GmbH cannot be held responsible for damage or lost or destroyed data 
caused by improper use or modification to the GUITAR RIG MOBILE I/O.

The information contained in this manual is believed to be correct at the time of release. 
However, Native Instruments reserves the right to make changes to the specifications at any 
time without notice or obligation to update existing units.
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3 Parts of the GUITAR RIG MOBILE I/O Audio 
Interface

1 The input socket (¼” jack, TRS stereo) will accept instrument level signals. It allows you 
to connect a variety of different sound sources, including your electric guitar or bass. For 
stereo input, a split (insert cable / y-cable, not included) is needed.

2 The input level control allows adjusting the amplification of the incoming audio signal.

3 The input activity LED indicates the level of the audio signal at the input. A green light 
shows that a signal is present, while a red light indicates clipping, meaning that the input 
level is set too high.

4 The output socket (¼” jack, TRS stereo) transmits the output signal received from your 
computer application, such as GUITAR RIG 4 or your sequencer. Depending on your 
amplification system, a split (insert cable / y-cable, not included) might be needed for 
stereo transmission.
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5 The output level control. Turn down volume before connecting anything to the output, 
especially headphones.

6 The USB activity LED shows that the GUITAR RIG MOBILE I/O is connected to a USB 
port.

7 The USB port allows connecting the unit to your computer. Your computer must fulfill the 
USB 2.0 specifications in order for the GUITAR RIG MOBILE I/O to work.
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4 Installation under Windows XP / Windows Vista
This chapter describes the basic installation of GUITAR RIG MOBILE on Windows XP and 
Vista, focusing on the GUITAR RIG MOBILE I/O audio interface. For detailed information about 
the GUITAR RIG 4 software, please consult the Application Reference. You can find it on 
the product CD or in the GUITAR RIG 4 menu under Help > Open Manual > Your Language.

4.1 Software Installation

Make sure you are logged in with administrator privileges. Do not connect the GUITAR RIG 
MOBILE I/O yet.

1. Browse the content of the product CD and locate the setup file. It is called “Guitar Rig 
4 Setup”. If you are using a download version of GUITAR RIG 4, you need to extract the 
setup files first.

2. Double-click “Guitar Rig 4 Setup” to start the installation procedure.
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3. Follow the on-screen instructions, which will guide you through the installation procedure.

4. You will be asked to specify the path to the plug-in folder of your DAW (Digital Audio 
Workstation, e.g. your sequencer software). If you are going to use GUITAR RIG 4 exclu-
sively in standalone mode, or if you don’t know what a plug-in is, just use the standard 
setting.

5. You will be asked if you want to install drivers for the GUITAR RIG audio interfaces. Select 
“Mobile I/O” and click on “Continue”.

6. During installation of the driver, several Windows security messages will show up, e.g. “The 
driver has not passed the Windows Logo Test” or “Windows can’t verify the publisher of 
this driver software”. Don’t worry, everything is fine here. Simply click “Continue Anyway” 
(Windows XP) or “Install this Driver Software Anyway” (Windows Vista) to continue the 
installation.
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7. Restart your computer upon completion.

The following applications have been placed onto your hard drive:

 • GUITAR RIG 4 – the fully featured standalone application.

 • GUITAR RIG 4 plug-ins – Use GUITAR RIG 4 as a plug-in for your Digital Audio Workstation 
(DAW) of choice. On Windows computers, GUITAR RIG 4 supports the VST and RTAS® 
plug-in formats.

 • Native Instruments Service Center – this application handles product activation as well as 
update management. Please refer to the Setup Guide for details.

 • The drivers for the GUITAR RIG MOBILE I/O audio interface.

% 
If you have never owned a Native Instruments product, you will need to register by following 
the on-screen instructions. More information about creating a NI User Account and about 

activating GUITAR RIG 4 is available in the Service Center Quick Start Guide and manual located in 
the Service Center installation folder.
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In case you want to install the hardware drivers only, a separate driver installer file is available 
on the installation CD. You can also download its latest version from the Support section of 
the Native Instruments website.

4.2 Hardware Installation

Use the supplied USB cable to connect the GUITAR RIG MOBILE I/O directly to a USB 2.0 
port on your computer.

GUITAR RIG MOBILE I/O is powered via USB. Operation is guaranteed only with a USB 2.0 
controller as a single device or with self-powered USB 2.0 hubs. On Windows XP systems, 
Service Pack 2 is required for GUITAR RIG MOBILE I/O to work – you can find out about your 
Windows version in the System Properties window.
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After successfully installing the driver, the GUITAR RIG MOBILE I/O will be recognized auto-
matically. If not, run the software installation again as explained above.

Several driver modules will be assigned to the GUITAR RIG MOBILE I/O now, each one caus-
ing a pop-up window in which you are asked how you want to install the new device. 

1. Choose to not connect to the “Windows Update Web site”.

2. Choose “Install the software automatically” (Windows XP) or “Locate and install driver 
software” (Windows Vista).
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3. Follow the on-screen instructions to complete this procedure.

4. During installation of the driver, several Windows security messages will show up, e.g. “The 
driver has not passed the Windows Logo Test” or “Windows can’t verify the publisher of 
this driver software”. Simply click “Continue Anyway” (Windows XP) or “Install this Driver 
Software Anyway” (Windows Vista) to continue the installation.

On a Windows computer, the driver is associated with a particular USB port. If you plug the 
USB cable into a different port than the one it was installed at, the driver assignment process 
starts again – if this happens, just follow the steps described above.

If at any time the computer does not seem to recognize the GUITAR RIG MOBILE I/O, discon-
nect the USB cable, wait a few seconds, then re-connect it. If the problem remains, restart 
your computer with the interface connected.
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4.3 Configuration

This chapter explains how to use the GUITAR RIG MOBILE I/O audio interface with Windows 
XP / Windows Vista and particularly with the included GUITAR RIG 4. It is assumed that you 
have already activated GUITAR RIG 4 using the Service Center – please refer to the Setup 
Guide for help on this process.

4.3.1 Configuring GUITAR RIG 4
We will now set up GUITAR RIG 4 to use the GUITAR RIG MOBILE I/O audio interface. Start 
the software before you proceed.

1. When the software is started for the first time, you will be prompted with the Audio Setup 
window automatically, where you need to make the following settings. To access these 
settings later on, select File > Audio and MIDI Settings from the program menu.

 

2. From the “Audio” tab, choose ASIO as the driver interface.

3. Select GUITAR RIG MOBILE I/O from the “Device” dropdown menu.
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If GUITAR RIG MOBILE I/O doesn’t appear in the list, something went wrong. Restart the 
installation as explained in section 4.1.

You can access the Driver Control Panel by clicking on “ASIO Config”. In the Driver Control 
Panel, two status fields on the bottom show whether the GUITAR RIG MOBILE I/O hardware 
is connected and ready to use.

 

The audio interface allows to be configured by the following parameters:

 • Presets: Several presets for common types of usage are included, from minimal latency 
suitable for fast systems with strong CPU power, to higher latencies suitable for slower sys-
tems. If you are experienced in setting up audio drivers and want to create your own custom 
settings, select User Defined Settings.

 • USB Buffersize and Audio Buffersize: These parameters are grayed out, unless you have 
selected User Defined Settings from the Presets Menu. Together, they define the system’s 
latency, i.e. the time that passes from the moment an audio signal is sent into the GUITAR 
RIG MOBILE I/O hardware until the moment you hear it in your headphones or your speak-
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ers. The value for Audio Buffersize must always be at least twice as large as the Usb 
Buffersize value. Note that the Usb Buffersize parameter has a direct impact on the CPU 
usage of the system. The resulting CPU usage differs between computers, so it could make 
sense to experiment with different settings.

 • Sample Rate: Choose a sample rate that is compatible with your music application and 
suited to your computing power. Per default, the sample rate is set to 44100 Hz (CD-Quality). 
Higher sample rates may improve sound quality, but cause a higher CPU load as well.

It is recommended that you try the latency presets first and then continue with the subse-
quent steps of the installation. Once you are finished, you should revisit the Audio and MIDI 
Settings to figure out the best latency setting for your system. If audio dropouts occur with 
the preset minimal latency, you can try the low latency or standard latency settings instead. 
Higher latency values will reduce the probability of audio dropouts.

4.3.2 Using GUITAR RIG MOBILE I/O as your Default Audio Interface
If you want to use the GUITAR RIG MOBILE I/O for playback of all audio applications on your 
computer (not only for music software), you have to set it as your default audio interface.

For Windows XP, this works as follows:

1. Open Start > Control Panel > Sounds and Audio Devices.

2. Select the “Audio” tab.

3. In the “Sound playback” and “Sound recording” sections, click on the Default Device 
menu, and then select GUITAR RIG MOBILE I/O.

4. Click Ok to close the “Sounds and Audio Devices” dialog.
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For Windows Vista, this works as follows:

1. Open Start > Control Panel > Hardware and Sound > Sound.

2. Select the “Playback” tab.

3. In the device list, select GUITAR RIG MOBILE I/O and click on “Set Default.”

4. Select the “Recording” tab.

5. In the device list, select GUITAR RIG MOBILE I/O and click on “Set Default.”

6. Click Ok to close the dialog.
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4.4 Audio Connections and Levels

In the following chapters you will learn how to connect your guitar and your monitoring sys-
tem to the GUITAR RIG MOBILE I/O and how to set the right amplification levels both on the 
hardware and on the software side of your setup.

Please start GUITAR RIG 4 before you proceed.

4.4.1 Connecting the Input and Adjusting the Input Level
1. Turn down the volume on your monitoring system to prevent hearing damages.

2. Plug the cable connected to your guitar or bass into the input jack socket of the interface.

Mind that, for an instrument that generates a stereo signal, you might need a split (insert 
cable / y-cable, not included) to route both channels to the stereo input jack.

In order to achieve the best sound quality by providing the interface with a sufficiently power-
ful signal, you need to carefully adjust the input level of the GUITAR RIG MOBILE I/O.
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The Input Level LED helps you identify the level of the incoming signal:

LED Status Meaning

LED is off No incoming signal

LED flashing green Incoming signal

LED flashing red Incoming signal is too loud

Before adjusting the input sensitivity, turn up the volume knob on your guitar. Strum some 
chords at the volume level you are typically playing at and monitor the Input Level LED:

1. Turn up the input level knob just until the LED starts turning red when you play.

2. At that point, slightly turn the knob down until the LED no longer turns red, even when 
you are playing really powerful chords.

Now the input sensitivity is set to its optimum level, enabling the GUITAR RIG MOBILE I/O 
to provide the highest dynamic range without clipping.

4.4.2 The Input Level of GUITAR RIG 4
It is assumed that your guitar is connected to the GUITAR RIG MOBILE I/O and its input level 
is properly adjusted (see section 4.4.1). Now you need to make sure that the input signal is 
processed at the right level by the software.

Please take a look at the header of the GUITAR RIG 4 window: It consists of the input module 
with channel selectors, a basic noise gate, the output module with a limiter and information 
about the processing power consumed.
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% 
For a detailed description and explanation of the Noise Reduction circuit, please refer to the 
GUITAR RIG 4 Application Reference included on the product CD.

Note that the Input Meter shows an amplitude when you are playing. It also features an inte-
grated volume fader that controls the input level of the software. Please adjust it to achieve 
the highest possible level for your signal without clipping. This is indicated by the Level Meter 
getting close to the red zone without actually hitting it.

Now we will set up the Input component to route your guitar signal to both channels. Because 
almost all guitars are mono, GUITAR RIG 4 will receive a mono signal which is transmitted 
on the left channel. Per default, GUITAR RIG 4 is set to process both input channels (L + R 
are activated), so the right input channel remains mute. To change this, click the “R” button 
on the left hand side of the Input Meter to deactivate the right input channel. This will route 
the mono signal to both input channels.

4.4.3 Connecting the Output
GUITAR RIG MOBILE I/O provides a stereo output which works both for amplification systems 
and for headphones. Keep in mind that using a mono cable (like a guitar cable) will result in 
the transmission of one channel only – you might need a split (insert cable / y-cable) to route 
both channels to the inputs of your amplification system.

Use a stereo cable to connect the GUITAR RIG MOBILE I/O to devices that feature a stereo 
input jack.
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Before turning on your power amplification system or putting on your headphones, make sure 
the output level of the audio interface is turned down.

 • If you are using an amplification system, connect the output jack to its input and turn it on.

 • If you are using headphones, connect them to the output jack and put them on.

 • Go to the Preset Browser and select a preset by clicking on it. Start playing and carefully 
turn up the output volume of the GUITAR RIG MOBILE I/O to the desired level. You’re all set 
now and ready to rock!

% 
If your instrument uses only one channel, set the other channel’s Gain Knob to zero.



GUITAR RIG MOBILE – 26

5 Installation under Mac OS X
This chapter describes the basic installation of GUITAR RIG MOBILE under Mac OS X, fo-
cusing on the GUITAR RIG MOBILE I/O audio interface. For detailed information about the 
GUITAR RIG 4 software, please consult the Application Reference. You can find it on the 
product CD or in the Guitar Rig 4 menu under Help > Open Manual > Your Language.

5.1 Software Installation

Make sure you are logged in with administrator privileges. Do not connect the GUITAR RIG 
MOBILE I/O yet.

1. Browse the content of the product disc and locate the file “Guitar Rig 4 Installer.” If you 
are using a download version of GUITAR RIG 4, you need to extract the installer file first.

2. Double-click the installer file to start the installation procedure.
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3. Follow the on-screen instructions, which will guide you through the installation procedure.

4. You will be asked if you want to install drivers for the GUITAR RIG audio interfaces. Select 
“MOBILE I/O” and click on “Continue.”

5. Restart your computer upon completion.

The following applications will be placed onto your hard drive:

 • GUITAR RIG 4 – the fully featured standalone application.

 • GUITAR RIG 4 plug-in – Use GUITAR RIG 4 as a plug-in for your Digital Audio Workstation 
(DAW) of choice.

 • Native Instruments Service Center – this application handles product activation as well as 
update management. Please refer to the Setup Guide for details.

 • The drivers for the GUITAR RIG MOBILE I/O audio interface.

% 
If you have never owned a NATIVE INSTRUMENTS product, you will need to register by 
following the on-screen instructions. More information about creating a NI User Account 

and about activating GUITAR RIG 4 is available in the Service Center Quick Start Guide and manual 
located in the Service Center installation folder.

In case you want to install the hardware drivers only, a separate driver installer file is available 
on the installation CD. You can also download its latest version from the Support section of 
the Native Instruments website.
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5.2 Hardware Installation

Use the supplied USB cable to connect the GUITAR RIG MOBILE I/O directly to a USB 2.0 
port on your computer.

GUITAR RIG MOBILE I/O is powered via USB. Operation is guaranteed only with USB 2.0 
controller as a single device or with self-powered USB 2.0 hubs.

After successfully installing the driver, the GUITAR RIG MOBILE I/O should be recognized au-
tomatically. If at any time the computer does not seem to recognize the GUITAR RIG MOBILE 
I/O, disconnect the USB cable, wait a few seconds, then re-connect it. If this does not solve 
the problem, restart your computer with the interface connected.

5.3 Configuration

This chapter explains how to use the GUITAR RIG MOBILE I/O audio interface under Mac 
OS X and particularly with the included GUITAR RIG 4. It is assumed that you have already 
activated GUITAR RIG 4 using the Service Center – please refer to the Setup Guide for help 
on this process.
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5.3.1 Configuring GUITAR RIG 4
We will now set up GUITAR RIG 4 to use the GUITAR RIG MOBILE I/O audio interface. Start 
the software before you proceed.

1. Start GUITAR RIG 4. When the software is started for the first time, you will be prompted 
with the Audio Setup window automatically, where you need to make the following set-
tings. If you want to access these settings later, select GUITAR RIG 4 > Preferences from 
the program menu.

 

2. On the “Audio” tab, choose CoreAudio as the “Driver” interface.

3. Select GUITAR RIG MOBILE I/O from the “Device” dropdown menu.

If GUITAR RIG MOBILE I/O does not appear in the list even though it is connected, something 
went wrong. Restart the installation as explained in section 5.1.
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The audio interface allows to be configured by the following parameters:

 • Sample Rate: Choose a sample rate that is compatible with your music application and 
suited to your computing power. Per default, the sample rate is set to 44100 Hz (CD-Quality). 
Higher sample rates may improve sound quality, but will cause a higher CPU load as well.

 • Latency: Use the Latency slider to set the buffer size of the audio interface, measured in 
samples. The buffer size has two effects: The higher it is set, the lower is the probability of 
dropouts during real-time audio processing. On the other hand, the size of the buffer di-
rectly affects the overall latency of your system. The time between the moment you hit a 
note and the moment you hear the processed sound will be longer if the buffer size is in-
creased.

It is recommended that you start with the default buffer size and continue with the subse-
quent steps of the installation. Once you are finished, you should load a clean preset and 
revisit the Audio and MIDI Settings to figure out the best latency setting for your system. This 
is done by gradually reducing the buffer size: Drag the latency slider to the left while playing 
something. Once you begin to hear crackles or dropouts, carefully drag the latency slider to 
the right until you reach the point where no crackles or dropouts occur.

5.3.2 Using GUITAR RIG MOBILE I/O as your Default Audio Interface
If you want to use the GUITAR RIG MOBILE I/O for all audio playback (not only for music soft-
ware), you have to set it as your default audio interface. For Mac OS X, this works as follows:

1. From the Apple menu, select System Preferences.

2. In the panel opened, click on “Sound.”
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3. On the Sound Effects tab, select GUITAR RIG MOBILE I/O in the “Play alerts and sound 
effects through” menu.

4. Click on the Output tab, and then select GUITAR RIG MOBILE I/O from the “Choose a 
device for sound output” list.

5. Click on the Input tab, and then select GUITAR RIG MOBILE I/O from the “Choose a 
device for sound input” list.

5.4 Audio Connections and Levels

In the following chapters you will learn how to connect your guitar and your monitoring sys-
tem to the GUITAR RIG MOBILE I/O and how to set the right amplification levels both on the 
hardware and on the software side of your setup.

Please start the GUITAR RIG 4 software before you proceed.
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5.4.1 Connecting the Input and Adjusting the Input Level
1. Turn down the volume on your monitoring system to prevent hearing damages.

2. Plug the cable connected to your guitar or bass into the input jack socket of the interface.

3. Mind that, for an instrument that generates a stereo signal, you might need a split (insert 
cable / y-cable, not included) to route both channels to the stereo input jack.

In order to achieve the best sound quality by providing the interface with a sufficiently power-
ful signal, you need to carefully adjust the input level of the GUITAR RIG MOBILE I/O.

The Input Level LED helps you to identify the level of the incoming signal:

LED Status Meaning

LED is off No incoming signal

LED flashing green Incoming signal

LED flashing red Incoming signal is too loud
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Before adjusting the input sensitivity, turn up the volume knob on your guitar. Strum some 
chords at the volume level you are typically playing at and look at the Input Level LED:

1. Turn up the input level knob just until the LED starts turning red when you play.

2. At that point, slightly turn the knob down until the LED no longer turns red, even when 
you are playing really powerful chords.

Now the input sensitivity is set to its optimum level, enabling the GUITAR RIG MOBILE I/O 
to provide the highest dynamical range without clipping.

5.4.2 The Input Level of GUITAR RIG 4
It is assumed that your guitar is connected to the GUITAR RIG MOBILE I/O and its input level 
is properly adjusted (see section 5.4.1). Now we need to make sure that the input signal is 
processed at the right level by the software.

Please take a look at the header of the GUITAR RIG 4 window: It consists of the input module 
with channel selectors, a basic noise gate, the output module with a limiter and information 
about the processing power consumed.

% 
For a detailed description and explanation of the Noise Reduction circuit, please consult the 
GUITAR RIG 4 Application Reference included on the product CD.

Note that the Input Meter shows an amplitude when you play. It also features an integrated 
volume fader that controls the input level of the software. Please adjust it to achieve the 
highest level possible for your signal without clipping. This is indicated by the Level Meter 
getting close to the red zone without actually hitting it.

Now we will set up the Input component to route your guitar signal to both channels. Because 
almost all guitars are mono, GUITAR RIG 4 will receive a mono signal which is transmitted 
on the left channel. Per default, Guitar Rig 4 is set to process both input channels (L + R are 
activated), so the right input channel remains mute. To change this, click on the “R” button 
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on the left hand side of the Input Meter to deactivate the right input channel. This will route 
the mono signal to both input channels.

5.4.3 Connecting the Output
GUITAR RIG MOBILE I/O provides a stereo output which works both for amplification systems 
and for headphones. Keep in mind that using a mono cable (like a guitar cable) will result in 
the transmission of one channel only – you might need a split (insert cable / y-cable) to route 
both channels to the inputs of your amplification system.

Use a stereo cable to connect the GUITAR RIG MOBILE I/O to devices that feature a stereo 
input jack.

Before turning on your power amplification system or putting on your headphones, make sure 
that the output level of the audio interface is turned down.



GUITAR RIG MOBILE – 35

 • If you are using an amplification system, connect the output jack to its input and turn it on.

 • If you are using headphones, connect them to the output jack and put them on.

 • Go to the Preset Browser and select a preset by clicking on it. Start playing and carefully 
turn up the output volume of the GUITAR RIG MOBILE I/O to the desired level. You’re all set 
now and ready to rock! 

% 
If your instrument uses only one channel, set the other channel’s Gain Knob to zero.
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6 Troubleshooting
Should you encounter any problems with your hardware, it is recommended that you follow 
these steps to find a solution to your problem before contacting Technical Support:

 • Visit NI’s online Knowledgebase. The easiest way to find it is by selecting Help > Visit the 
Knowledgebase… from the program menu.

 • Visit the NI User Forum on our website (http://www.native-instruments.com/forum/) and 
perform a search for helpful answers from the GUITAR RIG user community.

When contacting Technical Support, please make sure to have all relevant information about 
your computer at hand. For information about the driver’s version and the firmware revision, 
please check the Driver Control Panel.

 • On Windows computers you can find driver and firmware version by selecting the Driver 
Control Panel in Start > Programs > Native Instruments > GUITAR RIG MOBILE I/O Driver. 
Click on “About” to display the information desired.

 • On Mac OS X computers, you can access the Driver Control Panel from the system prefer-
ences. The information is shown in the main window.

Please visit this URL to contact the support team: 

http://www.native-instruments.com/support/

All products by Native Instruments are tested extensively in real life situations during the 
development phase. However, if your product needs to be returned, the Technical Support 
team will assign you an RA (Return Authorization) number to expedite the processing of your 
return. Please contact our Technical Support team prior to returning any item. Packages 
returned without this RA number will not be correctly identified and as such might not be 
processed efficiently.

http://www.native-instruments.com/forum/
http://www.native-instruments.com/support/
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6.1 Audio Issues

This section provides help with the most common audio issues you may encounter.

6.1.1 No Sound or Low Volume
There are several possible reasons for a silent or low audio output: 

 • Disconnected or broken cables. Please check all connections and cables.

 • Incorrect soundcard or audio input selected. Please check the Audio and MIDI Settings in 
the GUITAR RIG 4 menu if the GUITAR RIG MOBILE I/O driver is selected. 

 • Wrong channel selected in the Input module of GUITAR RIG 4. Switch to the other channel 
by choosing “L” in the INPUT Module.

 • The GUITAR RIG MOBILE I/O’s input gain is set too low. Turn up the Input Level.

 • Your instrument’s volume is turned down. Gradually turn up the volume knob.

6.1.2 Distorted Signal
If the audio signal sounds distorted, and no distortion is being added by the GUITAR RIG 4 
software, then this is most likely caused by the GUITAR RIG MOBILE I/O’s gain being set 
too high. Reduce the Input Level at the Interface to prevent the preamp from clipping. If 
your instrument delivers such a high signal that the preamp is always overdriven, you should 
reduce its volume. Usually, this only happens if the instrument is equipped with special high 
power pickups.

6.1.3 Noise
Audible hum can have several reasons, some of which are listed below:

 • Single-coil pickups are prone to collecting electrical interferences. Humbucker pickups 
produce much less hum, which is why they got their name.

 • Your guitar is too close to electrical equipment. To reduce this type of hum, move the guitar 
further away from the equipment.



GUITAR RIG MOBILE – 38

 • The guitar’s volume knob is set to a low level. Turn the knob up. If your guitar has more than 
one volume knob, make sure to check all knobs.

 • You are using a non-shielded or broken guitar cable. Your guitar’s shielding may also be 
insufficient. Try replacing the cable with a shielded model first. If this does not help, you 
should consider having your guitar’s electronics serviced and shielded by a professional.

If you’re experiencing hiss, the input level of the GUITAR RIG MOBILE I/O might be too low. 
Turn up the instrument’s volume or increase the input level on the GUITAR RIG MOBILE I/O. 
For more information on setting the input level, see section 4.4 (Windows XP/ Windows Vista) 
or section 5.4 (Mac OS X) of this manual.

6.1.4 Ground Loops
Ground loops (usually perceived as a hum or buzz) are a common problem when multiple 
electrical devices are connected to the same power circuit. The following steps should help 
to eliminate them:

 • Disconnect all devices you are not currently using, e.g. peripheral devices you may have 
connected to your computer (external data storage, CD burners).

 • Hook up a DI box behind the GUITAR RIG MOBILE I/O outputs. Most of these boxes have 
a ground lift switch, which allows breaking the ground loop and eliminating the noise.

6.2 Hardware-Related Problems

Check the Native Instruments website and the NI Service Center for updates of the GUITAR 
RIG MOBILE I/O driver and more information.

6.2.1 Driver Issues
Make sure that the GUITAR RIG MOBILE I/O is connected to the computer and open the 
Driver Control Panel. See the intro to this chapter on how to find the Control Panel.
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If the Control Panel is missing, the driver is most likely not installed at all. In this case, please 
re-install the driver as described above.

If all the drop-down menus of the Control Panel are grayed out, the GUITAR RIG MOBILE 
I/O is not recognized by the driver. Something might be wrong with the USB connection, see 
the following sections for details.

6.2.2 USB Issues
GUITAR RIG MOBILE I/O is a USB 2.0 interface and will not work on a USB 1.0/1.1 port. 
Always connect it directly to a USB 2.0 port on your computer. The port needs to fulfill the 
minimum power specification for a USB 2.0 port (500 mA). On certain computers, the USB 
2.0 ports do not meet the official USB 2.0 power specification. In this case, you may see a 
message, saying that there is not enough power available to operate your device. The GUITAR 
RIG MOBILE I/O may produce crackles or may not work at all.

 • If your computer is unable to supply the necessary amount of bus power, try connecting 
your GUITAR RIG MOBILE I/O to a USB 2.0 hub with external power-supply. Avoid connect-
ing other devices to the hub, as every bus-powered device will diminish the total amount of 
power available.

 • In case of failures, it is useful to check if GUITAR RIG MOBILE I/O works if you disconnect 
any other USB device from the computer.

 • If you are experiencing audio dropouts or other problems that may be related to the USB 
connection, try connecting the GUITAR RIG MOBILE I/O to another USB 2.0 port.

 • A bad USB cable can be responsible for audio dropouts and/or other connectivity problems. 
Try using a different cable bearing the official USB logo, in some cases using a shorter 
cable might help.

 • If you are experiencing problems with GUITAR RIG MOBILE I/O crashing or performing 
badly on a Windows machine, the first thing to do is to disable power management for the 
USB hubs, which is turned on by default. Go to the Device Manager (Control Panel > System 
> Hardware) and right click a USB hub to bring up its properties. On the Power Management 
page, uncheck all boxes. Repeat for each hub and reboot.
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6.2.3 Using GUITAR RIG MOBILE with a Laptop
Please check if your computer is suited for handling real-time audio processing without drop-
outs. There are a couple of freeware tools to analyze your system, for example:

www.thesycon.de/deu/latency_check.shtml

Start the tool with the GUITAR RIG MOBILE I/O disconnected. In case your computer is un-
able to handle glitch-free audio processing, the tool will show red latency bars and report this 
in the box on the bottom.

In general, it is not recommended to use laptops with shared-memory graphic cards. You will 
need all the memory and processing power available for your audio project.

There are ways to optimize your laptop’s audio performance:

 • It is not recommended to run the laptop on battery, as power management might slow the 
clock rate of the CPU down to save battery.

 • Disconnect all unused hardware (e.g. printer, scanner). This will increase the amount of 
processing power available for your music software.

 • Laptops often are equipped with built-in devices which disturb audio processing, most com-
monly a network adapter or a wireless LAN card. You might need to disable these devices 
while working with GUITAR RIG MOBILE.

http://www.thesycon.de/deu/latency_check.shtml
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7 Technical Specifications
This section contains all relevant technical specifications of the GUITAR RIG MOBILE I/O 
hardware.

7.1 Jacks and Sockets

 • 1 input jack for stereo ¼” jacks (6.3mm plugs)

 • 1 output jack for stereo ¼” jacks (6.3mm plugs)

 • 1 USB 2.0 Type B jack
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7.2 Audio Specifications

Audio Inputs (A/D)

Channels 2

Sample Rate 44.1, 48, 88.2, 96, 192 kHz

Bit Resolution 16, 24 Bit

Converter Cirrus Logic

Instrument Inputs

Input Impedance 1 MΩ unbalanced

Full Scale Level at Max. Gain -4.8 dBu

Maximum Input Level +15.8 dBu unbalanced

SNR (weighted) 100 dBu

THD+N 0.006%

Frequency Response (+/- 1 dBu) 10 - 40000 Hz
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Audio Outputs (D/A)

Channels 2

Sample Rate 44.1, 48, 88.2, 96, 192 kHz

Bit Resolution 16, 24 Bit

Converter Cirrus Logic

Line Outputs

Output Impedance 100 ohms unbalanced, 200 ohms balanced

Maximum Output Level +14.9 dBu

SNR (weighted) 100 dBu

THD+N 0.006%

Frequency Response (+/- 1 dBu) 10 - 40000 Hz
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Headphone Output

Load Impedance 16 - 600 ohms

Maximum Output Level  
(100 ohms load)

2.165 V RMS (load 100 ohms), 4.345 V RMS  
(no load)

SNR (weighted) 100 dB

THD+N (100 ohms) 0.06%

Frequency Response (+/- 1 dBu) 10 - 40000 Hz

7.3 Power Supply

Via USB 2.0 interface, 5V/ 500mA bus power

No additional power supply or battery is needed, only power from the USB is required. 
However, proper operation is guaranteed only when MOBILE I/O is used as a single device 
with a USB 2.0 controller, or with a self-powered USB 2.0 hub.

7.4 Dimensions and Weight

Dimensions: 90 x 58 x 24 mm (3.54 x 2.28 x 0.94 in)

Weight: 90 g (0.198 lb)
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7.5 Environmental Specifications

Operating temperature: 0°C to 40°C (32°F to 104°F) (85% non-condensing humidity)

Storage temperature: -20°C to 50°C (-4°F to 122°F) (85% non-condensing humidity)

7.6 System Requirements

7.6.1 General System Specifications
Windows XP with Service Pack 2 or Windows Vista (32/64 bit), Intel® Pentium™ or AMD® 
Athlon™ XP 1.4 GHz, 1024 MB RAM, USB 2.0

Mac OS 10.5, Intel® Core™ Duo 1.66 GHz, 1024 MB RAM, USB 2.0

7.6.2 Supported Driver Interfaces
 • Mac OS: Core Audio™

 • Windows: ASIO® (recommended), DirectSound™, WASAPI™

7.6.3 Supported Platforms 
 • Mac OS: stand-alone, VST®, Audio Units™, RTAS® (Pro Tools 7/8)

 • Windows: stand-alone, VST®, RTAS® (Pro Tools 7/8)
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